


Excel Tutorial 2: Formatting a Workbook  

 
TRUE/FALSE 

 

 1. Formatting changes only the appearance of data - it does not affect the data itself. 

 

ANS: T PTS: 1 REF: EX 58 

 

 2. By default, text is black and cells have no background fill color. 

 

ANS: T PTS: 1 REF: EX 60 

 

 3. You can use a picture or image as the background for all the cells in a worksheet.  

 

ANS: T PTS: 1 REF: EX 63 

 

 4. Background images do not print in Excel. 

 

ANS: T PTS: 1 REF: EX 63 

 

 5. After you merge a range into a single cell, you cannot realign its content.  

 

ANS: F PTS: 1 REF: EX 69 

 

 6. You can rotate cell contents in Excel so that they appear at any angle or orientation.  

 

ANS: T PTS: 1 REF: EX 70 

 

 7. When a worksheet is printed, the gridlines that surround the cells are printed by default. 

 

ANS: F PTS: 1 REF: EX 71 

 

 8. Modifying the number format affects the value stored in the workbook.  

 

ANS: F PTS: 1 REF: EX 73 

 

 9. If you revise a style in Excel, the appearance of any cell formatted with that style must be updated manually.  

 

ANS: F PTS: 1 REF: EX 76 

 

 10. In Excel, if the built-in styles don’t meet your needs, you can modify an existing style or create a new one.  

 

ANS: T PTS: 1 REF: EX 78 

 

 11. If you use colors that are not part of a theme, changing the theme will not change those colors.  

 

ANS: T PTS: 1 REF: EX 79 

 

 12. A table style treats the table as a single object rather than a collection of cells.  

 

ANS: T PTS: 1 REF: EX 83 

 



 13. If you insert a new row at the top of the table, the new row becomes the header row and is formatted with the table style.  

 

ANS: T PTS: 1 REF: EX 84 

 

 14. When you add a table style, be sure that all formatting is as you want it because table styles in Excel cannot be formatted once applied.  

 

ANS: F PTS: 1 REF: EX 85 

 

 15. Conditional formats are dynamic, so a cell’s appearance will change to reflect its current value.  

 

ANS: T PTS: 1 REF: EX 86 

 

 16. A conditional format can make negative numbers red and positive numbers black.  

 

ANS: T PTS: 1 REF: EX 86 

 

 17. When using a data bar, changing the value of one cell in the range will not affect the size of all the other cells’ data bars. 

 

ANS: F PTS: 1 REF: EX 88 

 

 18. Top/Bottom Rules is a form of Conditional Formatting that allows you options to select the bottom 10% of data.  

 

ANS: T PTS: 1 REF: EX 92 

 

 19. When you use conditional formatting to highlight cells in a worksheet, you do not need to include a legend.  

 

ANS: F PTS: 1 REF: EX 93 

 

 20. Once you hide a row, it remains hidden as long as the workbook is active.  

 

ANS: F PTS: 1 REF: EX 95 

 
MODIFIED TRUE/FALSE 

 

 1. Excel uses themes to maintain a consistent look within a workbook. ____________________ 

 

ANS: T   PTS: 1 REF: EX 58 

 

 2. The appearance of text is determined by its type character. ____________________ 

 

ANS: F 

typeface 

type face 

 

PTS: 1 REF: EX 58 

 

 3. Typefaces are organized into colors. ____________________ 

 

ANS: F, fonts 

 

PTS: 1 REF: EX 58 | EX 59   

 

 4. Font sizes are measured in points, where one is approximately 1/72 of an inch. ____________________ 



 

ANS: T   PTS: 1 REF: EX 59 

 

 5. A sans serif font, such as Arial, does not include decorative strokes on each character. ____________________  

 

ANS: T   PTS: 1 REF: EX 59 

 

 6. In Microsoft Excel, you can open an extended color palette of 134 standard colors. ____________________ 

 

ANS: T   PTS: 1 REF: EX 60 

 

 7. Calculated values too large to fit into the cell are displayed in scientific notation. ____________________ 

 

ANS: T   PTS: 1 REF: EX 65 

 

 8. Although dates and times in Excel appear as text, they are actually numbers. ____________________ 

 

ANS: T   PTS: 1 REF: EX 66 

 

 9. To filter data in an Excel table, use filter blocks in the header row. ____________________ 

 

ANS: F 

filter arrows 

filter arrow 

the filter arrow 

 

PTS: 1 REF: EX 84 

 

 10. Table styles have six elements that can be turned on or off. ____________________  

 

ANS: T   PTS: 1 REF: EX 84 

 

 11. A conditional format applies formatting only when a cell’s value meets a specified condition. ____________________  

 

ANS: T   PTS: 1 REF: EX 86 

 

 12. In Excel, large data values are associated with shorter data bars. ____________________ 

 

ANS: F, longer 

 

PTS: 1 REF: EX 87 

 

 13. Use data bars when you’re more interested in the “big picture” rather than specific cell values. ____________________ 

 

ANS: T   PTS: 1 REF: EX 94 

 

 14. If contents do not fit across the Excel page, change the orientation to Portrait orientation. ____________________ 

 

ANS: F 

Landscape 

land scape 

 

PTS: 1 REF: EX 96 

 



 15. A print area can cover an adjacent or nonadjacent range. ____________________ 

 

ANS: T   PTS: 1 REF: EX 96 

 
MATCHING 

 

Match each of the following icons with the description that most closely matches its function. 

a. 
 

g. 
  

b. 
 

h. 
 

c. 
 

i. 
 

d. 
 

j. 
 

e. 
 

k. 
 

f. 
 

l. 
 

 

 

 1. Aligns the cell content with the cell’s bottom edge  

 

 2. Increases the size of the indentation used in the cell  

 

 3. Aligns the cell content with the cell’s right edge 

 

 4. Decrease Decimal button 

 

 5. Rotates the cell content to an angle within the cell 

 

 6. Aligns the cell content with the cell’s top edge 

 

 7. Aligns the cell content with the cell’s left edge 

 

 8. Merges the selected cells into a single cell  

 

 9. Accounting Number Format button 

 

 10. Horizontally centers the cell content within the cell  

 

 11. Forces the cell text to wrap within the cell borders  

 

 12. Decreases the size of the indentation used in the cell  

 

 1. ANS: E PTS: 1 REF: EX 68 

 

 2. ANS: J PTS: 1 REF: EX 68 

 

 3. ANS: H PTS: 1 REF: EX 68 

 

 4. ANS: A PTS: 1 REF: EX 66 

 

 5. ANS: K PTS: 1 REF: EX 68 

 

 6. ANS: C PTS: 1 REF: EX 68 

 

 7. ANS: F PTS: 1 REF: EX 68 

 

 8. ANS: D PTS: 1 REF: EX 68 

 

 9. ANS: B PTS: 1 REF: EX 66 

 

 10. ANS: G PTS: 1 REF: EX 68 

 

 11. ANS: L PTS: 1 REF: EX 68 

 

 12. ANS: I PTS: 1 REF: EX 68 

 
MULTIPLE CHOICE 

 

 1. One of the benefits of Live Preview is that ____. 

a. it lets you see and evaluate different formats as you develop your workbook 

b. it shows you what a document will look like when printed 

c. it applies thematic styles to your document 

d. it allows you to track changes in your document 
 

 



ANS: A PTS: 1 REF: EX 58 

 

 2. Typeface is the specific design used for characters and includes ____. 

a. lettering c. punctuation marks and symbols 

b. numbering d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 58 

 

 3. A ____ is not a type of font. 

a. serif  c. theme 

b. sans serif  d. true type 
 

 

ANS: D PTS: 1 REF: EX 59 

 

 4. When you don’t want to associate a font with a particular design, you use a ____ font. 

a. theme c. sans serif 

b. serif d. non-theme 
 

 

ANS: D PTS: 1 REF: EX 59 

 

 5. Italic, bold, bold italic, and underline are examples of ____. 

a. font themes c. graphics 

b. font styles d. character settings 
 

 

ANS: B PTS: 1 REF: EX 59 

 

 

 

 6. In the figure above, Item 1 points to the ____. 

a. Font Size arrow c. Theme fonts 

b. Font arrow d. Font color 
 

 

ANS: B PTS: 1 REF: EX 59 

 



 7. To view theme and non-theme fonts in the above figure, look to the area indicated by Item ____. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: D PTS: 1 REF: EX 59 

 

 8. In the above figure, the ____ indicates the font is 11pt. 

a. Font arrow c. Font color 

b. Font size arrow d. Font graphic 
 

 

ANS: B PTS: 1 REF: EX 59 

 

 9. In the above figure, Item 3 indicates that Cambria and Calibri are the ____ for this document. 

a. font styles c. theme fonts 

b. font sizes d. non-theme fonts 
 

 

ANS: C PTS: 1 REF: EX 59 

 

 10. To change the font size one point at a time, in the Font group on the Home tab, click the ____ button. 

a. Increase Font Size c. Change Font Size 

b. Decrease Font Size d. either a or b 
 

 

ANS: D PTS: 1 REF: EX 60 

 

 11. ____ theme colors are designated for text and background, ____ colors are used for accents and highlights, and ____ colors are used for 

hyperlinks. 

a. Four, two, six c. Four, six, two 

b. Two, four, six d. Six, four, two 
 

 

ANS: C PTS: 1 REF: EX 60 

 

 12. You can create a ____ color by specifying a mixture of red, blue, and green color values. 

a. standard c. theme  

b. custom d. automatic 
 

 

ANS: B PTS: 1 REF: EX 60 

 

 13. To add a ____ to a sheet tab, click the Format button, point to Tab color, and then click a color. 

a. fill color c. format color 

b. tab setting d. formatting style 
 

 

ANS: A PTS: 1 REF: EX 61 

 

 14. Selecting the Font Color button arrow will display ____. 

a. 10 theme colors c. a ScreenTip displaying the color name 

b. a standard color bar d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 61 

 

 15. The ____ appears when you select text and contains buttons for commonly used text formats. 

a. Formatting arrow c. Mini toolbar 

b. Font style button d. Style toolkit 
 

 

ANS: C PTS: 1 REF: EX 62 

 

 16. When creating an Excel document, you should avoid using ____ text and background together, since this is the most common form of color 

blindness. 



a. red and green c. black and white 

b. yellow and blue d. red and yellow 
 

 

ANS: A PTS: 1 REF: EX 64 

 

 17. By default, values appear in the ____ and generally display numbers exactly as you type them. 

a. Home tab c. General number toolbar 

b. General number format d. currency format 
 

 

ANS: B PTS: 1 REF: EX 65 

 

 18. Which of the following can you format using the Number group in Excel’s home tab?  

a. currency formats c. commas as a thousands separator 

b. numbers to percentages d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 65 

 

 19. Using date and time in Excel, you can ____. 

a. calculate date and time intervals c. auto-format dates for international users 

b. format a date or time value d. both a and b 
 

 

ANS: D PTS: 1 REF: EX 66 

 

 20. Dates and times in Excel measure intervals between the specified date and time and ____. 

a. January 1, 2000 at 12:00pm c. January 1, 1900 at 12:00am 

b. January 1, 2000 at 12:00am d. January 1, 1900 at 12:00pm 
 

 

ANS: C PTS: 1 REF: EX 66 

 

 21. In Excel, dates are ____-aligned in the cell by default, regardless of date format. 

a. right c. center 

b. left d. not 
 

 

ANS: A PTS: 1 REF: EX 67 

 

 22. As a general rule, you should ____. 

a. center column titles, left-align text, and right-align numbers 

b. center column titles, right-align text, and left-align numbers 

c. right-align column titles, left-align text, and right-align numbers 

d. left-align column titles, left-align text, and right-align numbers 
 

 

ANS: A PTS: 1 REF: EX 67 

 

 23. ____ merges each of the rows in the selected range across the columns in the range. 

a. Merge build c. Merge Across  

b. Merge and Center d. Merge Cells 
 

 

ANS: C PTS: 1 REF: EX 69 

 

 24. In Excel, to merge cells A1, B1, C1, D1, and E1, ____ is the correct reference for the merged cell. 

a. A1!E1! c. A1:E1 

b. A1$E1$ d. A1-E1 
 

 

ANS: C PTS: 1 REF: EX 70 

 

 25. Options to rotate cells in Excel are available using the ____ button in the Alignment group on the Home tab. 

a. Format c. Sorter 



b. Orientation d. Alignment 
 

 

ANS: B PTS: 1 REF: EX 69 

 

 26. You can add a border in Excel ____. 

a. to enhance readability c. and specify the thickness 

b. to the top, right, or bottom of a cell d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 71 

 

 27. All of the following options are available on the Format Cells dialog box except ____. 

a. number c. border 

b. font d. size 
 

 

ANS: D PTS: 1 REF: EX 72 

 

 28. In the Format Cells dialog box, the ____ tab allows you to format currency by choosing decimal places, comma separators, and regular number 

displays. 

a. Number c. Alignment 

b. Font d. Protection 
 

 

ANS: A PTS: 1 REF: EX 73 

 

 

 

 29. In the above figure, you can choose a border line style from the area indicated by Item ____. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: B PTS: 1 REF: EX 74 

 

 30. Item 3 in the figure above shows green as the selected background ____ for the cells. 

a. font c. color 

b. format d. view 
 

 

ANS: C PTS: 1 REF: EX 74 

 

 31. To see a preview of the selected border style, look to the area indicated by Item ____ in the above figure. 

a. 1 c. 5 



b. 4 d. 6 
 

 

ANS: D PTS: 1 REF: EX 74 

 

 32. The bottom border of the selected cells is indicated by Item ____ in the above figure. 

a. 4 c. 6 

b. 5 d. 7 
 

 

ANS: D PTS: 1 REF: EX 74 

 

 33. Item 5 in the above figure adds ____.  

a. no lines to the cell or range c. a background color to the cells 

b. lines around the cell or range d. lines within the cell range 
 

 

ANS: D PTS: 1 REF: EX 74 

 

 34. If you don’t want to add any lines around the cell or range, click the button indicated by Item ____ in the above figure. 

a. 1 c. 5 

b. 4 d. 6 
 

 

ANS: A PTS: 1 REF: EX 74 

 

 35. To add a green background to selected cells, you would choose ____ in the above figure. 

a. the green color line in Item 3 c. the Font tab 

b. the Fill tab d. none of the above 
 

 

ANS: B PTS: 1 REF: EX 74 

 

 36. Item 4 in the above figure adds ____. 

a. no lines to the cell or range c. a background color to the cells 

b. lines around the cell or range d. lines within the cell range 
 

 

ANS: B PTS: 1 REF: EX 74 

 

 37. The Paste Options button allows you to ____. 

a. keep source formatting c. copy values only 

b. copy formatting only d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 75 

 

 38. When using the Format Painter, double-click the Format Painter button to copy formatting and click the Format Painter again to ____. 

a. turn it on c. copy formatting 

b. turn it off d. paste formatting 
 

 

ANS: B PTS: 1 REF: EX 75 

 

 39. Put the following five steps in the order in which you would perform them to use the Paste Special function: ____. 

1. Select and copy a range. 

2. Click the Paste button arrow in the Clipboard group. 

3. Specify exactly what you want to paste.  

4. Click Paste Special to open the dialog box. 

5. Select the range where you want to paste the Clipboard contents. 

a. 1, 2, 4, 3, 5 c. 1, 5, 2, 4, 3 

b. 1, 2, 4, 5, 3 d. 1, 5, 2, 3, 4 
 

 

ANS: C PTS: 1 REF: EX 76 

 



 40. In the Paste Special dialog box, you can ____ 

a. select to rotate selected range 90 degrees c. paste values and formats 

b. paste only values d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 76 

 

 41. To create a new style in Excel, open the Cell Styles gallery and click ____. 

a. Create New Cell c. Open New Cell 

b. New Cell Style d. New Cell Gallery 
 

 

ANS: B PTS: 1 REF: EX 78 

 

 42. ____ use the same file format for their theme files. 

a. Microsoft Word, Access, and Excel c. Microsoft Excel and PowerPoint 

b. Microsoft Word and Excel d. Microsoft Word, Excel, and PowerPoint 
 

 

ANS: D PTS: 1 REF: EX 80 

 

 43. You can treat a range of data as a distinct object in a worksheet known as a(n) ____. 

a. Excel table c. data range 

b. spreadsheet d. data set 
 

 

ANS: A PTS: 1 REF: EX 82 

 

 44. A(n) ____ specifies formats for elements in an Excel table, such as font color, fill color, and so forth. 

a. sheet format c. table style 

b. Excel table d. style guide 
 

 

ANS: C PTS: 1 REF: EX 82 

 

 45. The most efficient way to format an entire table is to ____. 

a. select all and format each element c. use the format painter 

b. use a table style  d. format each cell individually 
 

 

ANS: B PTS: 1 REF: EX 82 

 

 46. To apply banded rows in Excel, you need to ____. 

a. use the Format table button c. verify the range and table headers 

b. choose a table style d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 83 

 

 47. Applying a table style marks the range as a table, making available tools designed for analyzing tabular data, including ____. 

a. the ability to sort data 

b. transferring data to and from an external file 

c. filtering data to show only rows that match specified criteria 

d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 84 

 

 48. In Excel, the table style ____ inserts a new row at the bottom of the table that adds the column values. 

a. Header Row c. First Row 

b. Total Row d. Banded Row 
 

 

ANS: B PTS: 1 REF: EX 84 

 

 49. In Excel, the ____ table style formats alternating columns in different colors. 



a. Banded Rows c. Last Column 

b. Banded Columns d. First Column 
 

 

ANS: B PTS: 1 REF: EX 84 

 

 

 

 50. In the above figure, the filter arrow is ____. 

a. indicated by Item 1 c. indicated by Item 3 

b. indicated by Item 2 d. not represented 
 

 

ANS: C PTS: 1 REF: EX 84 

 

 51. The header row in the above figure is ____. 

a. indicated by Item 1 c. indicated by Item 3 

b. indicated by Item 2 d. not shown 
 

 

ANS: A PTS: 1 REF: EX 84 

 

 52. The area indicated by Item 2 in the above figure shows ____. 

a. banded rows c. alternating rows 

b. banded columns d. special formatting 
 

 

ANS: A PTS: 1 REF: EX 84 

 

 

 

 53. In the above figure, table styles are ____. 

a. shown in Item 1 c. not shown 

b. shown in Item 2 d. not used in Excel 
 

 

ANS: B PTS: 1 REF: EX 85 

 

 54. You would use Item 1 in the figure above to ____. 

a. select Header Row c. Select Banded Columns 

b. select First Column d. any of the above 
 

 



ANS: D PTS: 1 REF: EX 85 

 

 55. To remove banded rows from an Excel table, first you need to select the ____ tab on the Ribbon. 

a. Insert c. Design  

b. Home d. Page 
 

 

ANS: C PTS: 1 REF: EX 85 

 

 56. All of the following are conditional formats in Excel except ____. 

a. data bars c. font sets 

b. highlighting d. icon sets 
 

 

ANS: C PTS: 1 REF: EX 87 

 

 57. A ____ is a horizontal bar added to the background of a cell to provide a visual indicator of a cell’s value. 

a. data chart c. data bar 

b. data line d. data set 
 

 

ANS: C PTS: 1 REF: EX 87 

 

 58. Data bar ____ is based on a cell’s value. 

a. length c. height 

b. width d. depth 
 

 

ANS: A PTS: 1 REF: EX 87 

 

 59. To remove the data bars from B2 through C6, it is most efficient to ____. 

a. manually delete them c. click Clear All Rules 

b. click Clear Rules from Table d. click Clear Rules from Selected Cells 
 

 

ANS: D PTS: 1 REF: EX 89 

 

 60. In conditional formatting, to highlight only cells that contain a specific date, select the rule____. 

a. A Date Occurring c. Text That Contains 

b. Duplicate Values d. Between 
 

 

ANS: A PTS: 1 REF: EX 90 

 

 61. As a general rule, limit highlight rules to ____. 

a. only 1 c. less than 5 

b. 1 or 2 d. any number 
 

 

ANS: B PTS: 1 REF: EX 94 

 

 62. To view certain columns on a large database, a good option is to ____. 

a. hide columns without information you need 

b. delete columns you aren’t viewing 

c. highlight columns you want to view 

d. use data bars to find content 
 

 

ANS: A PTS: 1 REF: EX 94 

 

 63. When preparing to print, you have the option to select ____. 

a. the position of the report on the page c. to include headers or footers 

b. the orientation of the page d. all of the above 
 

 

ANS: D PTS: 1 REF: EX 95 



 

 64. Setting the ____ to A1:L10 will print only data in those cells. 

a. Page Format c. Page Break 

b. Print Area d. Print Preview 
 

 

ANS: B PTS: 1 REF: EX 96 

 

 65. To avoid splitting a worksheet in awkward places, you can insert a(n) ____ to specify a specific breaking point. 

a. page break c. print area 

b. manual page break d. selection  
 

 

ANS: B PTS: 1 REF: EX 96 

 

 66. To set a page break in Excel, ____. 

a. select the first cell below the row where you want to insert a page break 

b. select the first cell above the row where you want to insert a page break 

c. select the row above where you want to insert a page break 

d. select the row below where you want to insert a page break 
 

 

ANS: A PTS: 1 REF: EX 97 

 

 67. A ____ indicates a manual page break. 

a. dashed blue line c. dashed red line 

b. solid blue line d. solid red line 
 

 

ANS: B PTS: 1 REF: EX 97 

 

 68. Information that prints on each page, like a company name or logo, may be set as a(n) ____. 

a. print setup c. text header 

b. copied text d. print title 
 

 

ANS: D PTS: 1 REF: EX 98 

 

 69. The code ____ will display the filename of the current workbook. 

a. &name c. +name 

b. &[File] d. +[File] 
 

 

ANS: B PTS: 1 REF: EX 99 

 

 70. The header and footer sections include ____. 

a. a left and right section c. a top and bottom section 

b. a center section only d. a left, right, and center section 
 

 

ANS: D PTS: 1 REF: EX 99 

 

Case Based Critical-Thinking Questions 

 

Case 1 

Karl has been working on a field survey project where he has gathered data from across five cities in the last six months.  Karl has a lot of data 

to report and needs help organizing his data sheet for an effective presentation. 

 

 71. Karl has chosen green as the background color for his workbook.  Karl should not use ____ for any of the font or highlight colors. 

a. red c. black 

b. white d. any color is fine 
 

 

ANS: A PTS: 1 REF: EX 64 TOP: Critical Thinking 



 

 72. In column C, there are too many numbers after the decimal place.  Karl does not need this level of detail as it is distracting from the data, and 

you really don’t need more than two numbers after the decimal.  How could Karl make the data appear cleaner? 

a. reenter all numbers 

b. decrease column width 

c. decrease font size 

d. use Number group to decrease # of digits displayed 
 

 

ANS: D PTS: 1 REF: EX 65 TOP: Critical Thinking 

 

 73. Karl cannot increase the width of his worksheet or he will not be able to print it on one sheet.  However, his columns are truncating his content.  

What solution could Karl use for making his text visible without losing data? 

a. abbreviate all text c. click Wrap text 

b. reduce the font size to 8 pt d. delete one column 
 

 

ANS: C PTS: 1 REF: EX 69 TOP: Critical Thinking 

 

 74. Karl would like to center a title across the top of his data.  His data runs across five columns, from column A to column E.  One way he could 

accomplish this is to ____.  

a. type the data in A1 and Merge cells 

A1:A5 

c. type the data in C1 

b. type the data in A1 and Merge cells A1:E1 d. choose Center from the Format menu 
 

 

ANS: B PTS: 1 REF: EX 69 TOP: Critical Thinking 

 

 75. Karl needs to format several cells with 11pt Calibri font with 2 decimals, right-align the text, and format font color to blue.  The most efficient 

way to accomplish this would be to ____. 

a. use Format Painter 

b. format each element using the Toolbar 

c. select all and use the Formatting dialog box 

d. apply a table style 
 

 

ANS: D PTS: 1 REF: EX 76 TOP: Critical Thinking 

 

Case Based Critical Thinking Questions 

 

Case 2 
Ajeesh is part of a team creating a number of files with Microsoft Office.  Ajeesh is working with four other team members to create individual 

files for a joint presentation.  Ajeesh is in charge of the Excel workbook for his team.  

 

 76. Ajeesh wants his team’s documents to have a common style and appear as a cohesive unit for a large end-of-year presentation.  The easiest 

way to make all documents appear as a cohesive unit is to ____.  

a. save the styles and themes as permanent files for other members of his workgroup 

b. copy and paste styles when each team member opens a new document 

c. store all the team’s files on a network drive 

d. use the Save As function when creating new files 
 

 

ANS: A PTS: 1 REF: EX 80 TOP: Critical Thinking 

 

 77. Ajeesh needs to draw special attention to the Total costs column in his data set.  The most effective way to set apart this column is to ____.  

a. use boldface font c. add a border around the cells 

b. add color to the text d. add a data bar 
 

 

ANS: D PTS: 1 REF: EX 87 TOP: Critical Thinking 

 



 78. Ajeesh wants to format his Excel table so that every other line is light yellow.  He’s seen this done on other reports and believes it will make 

his data easier to follow across rows.  Ajeesh begins to apply highlighting to every other line by using the Ctrl key to select the odd rows, but 

worries that adding and deleting rows will ruin the consistency of his format.  What is an alternate solution for Ajeesh? 

a. Ajeesh should continue with his current formatting 

b. use banded rows  

c. Ajeesh should not apply this formatting  

d. use Format Painter 
 

 

ANS: B PTS: 1 REF: EX 82 TOP: Critical Thinking 

 

 79. Ajeesh wants to print two separate parts of his second spreadsheet - one for the cell range B6:F15 and the other for the full sheet.  Ajeesh’s 

best option is to ____. 

a. copy and paste B6:F15 to a separate worksheet 

b. cut B6:F15 and print in a separate document  

c. adjust the margins to print the selected range 

d. set Print Areas for the two selections 
 

 

ANS: D PTS: 1 REF: EX 96 TOP: Critical Thinking 

 

 80. Ajeesh has copied his data set to a new spreadsheet where he wants to draw attention to data that received above a 75% approval rating.  To 

highlight these numbers, Ajeesh could apply ____. 

a. the Greater Than rule with Conditional Formatting 

b. the Format Painter 

c. a bold format to all text 

d. manual highlighting to each percentage 
 

 

ANS: A PTS: 1 REF: EX 90 TOP: Critical Thinking 

 
COMPLETION 

 

 1. ____________________ is the process of changing a workbook’s appearance by defining the fonts, styles, colors, and decorative features. 

 

ANS: Formatting 

 

PTS: 1 REF: EX 58 

 

 2. A ____________________ is a collection of formatting that specifies the fonts, colors, and graphical effects used throughout the workbook.  

 

ANS: theme 

 

PTS: 1 REF: EX 58 

 

 3. As you work, ____________________ shows the effects of formatting options on the workbook’s appearance before you apply them.  

 

ANS: Live Preview 

 

PTS: 1 REF: EX 58 

 

 4. Times New Roman, a ____________________ font, has extra decorative strokes at the end of each character.  

 

ANS: serif 

 

PTS: 1 REF: EX 59 

 



 5. ____________________ are the 12 colors that belong to the workbook’s theme. 

 

ANS: Theme colors 
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 6. You increase the indentation by roughly one character each time you click the ____________________ button in the Alignment group on the 

Home tab.  

 

ANS: Increase Indent 
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 7. One way to align text over several columns or rows is to ____________________, or combine, several cells into one cell.  

 

ANS: merge  
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 8. The ____________________ tab in the Format Cells dialog box in Excel provides options for locking or hiding cells to prevent other users 

from modifying their contents. 

 

ANS: Protection 
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 9. The ____________________ tab in the Format Cells dialog box in Excel provides options for creating and applying background colors and 

patterns to cells. 

 

ANS: Fill 
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 10. The ____ copies the formatting from one cell or range to another cell or range without duplicating any of the data. 

 

ANS: Format Painter 
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 11. A ____________________ is a collection of formatting, such as italic, red, 11 pt, Times New Roman.  

 

ANS: style 
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 12. To display alternate rows with different fill colors in Excel, use the effect known as ____________________.  

 

ANS: banded rows 
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 13. A ____________________ formats the entire table as a single unit. 

 

ANS: table style 
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 14. One of the benefits of ____________________ is that it helps you analyze data by highlighting significant trends in data.  

 

ANS: formatting 
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 15. To remove data bars in Excel, click ____________________ from the Conditional Formatting button. 

 

ANS: Clear Rules 
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 16. A ____________________ is a key that shows each color used in the worksheet and what it means.  

 

ANS: legend 
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 17. If a worksheet says 60% in the top bar, you have used the ____ feature.  

 

ANS: Zoom 
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 18. When a printout extends to multiple pages, Excel prints as much as possible on one page then inserts a _______________ and continues 

printing the remaining worksheet content on the next page.  

 

ANS: page break 
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 19. A ____________________ is text printed in the bottom margin of each page.  

 

ANS: footer 
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 20. A ____________________ is text printed in the top margin of each page. 

 

ANS: header 
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ESSAY 

 

 1. Explain why it is important to use proper formatting, citing at least three benefits of a well-formatted workbook.  

 

ANS:  



Proper formatting is a balance between too little and too much formatting, both of which can make data hard to understand. A well-formatted 

workbook helps accentuate important trends and relationships in data.  A well-formatted workbook can be (1) be easier to read, (2) establish a 

sense of professionalism, (3) help draw attention to the points you want to make, and (4) provide continuity between worksheets. 

 

PTS: 1 REF: EX 58 TOP: Critical Thinking  

 

 2. Color allows you to effectively enhance a workbook, but could you ever use too much or “bad” color?  Explain how or when color might 

detract from a workbook. Give at least four tips for effective color use. 

 

ANS:  

Too much color can be just as bad as not enough color.  Overuse of color can cause readers’ eyes to wander around the workbook without 

focusing on a central point.   

 

Students should note at least four of the following tips: 

* Use colors from the same theme. 

* Use colors to differentiate content types and direct users where to enter data. 

* Avoid garish color combinations that can annoy the reader or be difficult to read. 

* Print on color and black-and-white printers to ensure output is readable in both formats. 

* Understand printer limitations; colors may look good on the monitor but not print well. 

* Be sensitive to your audience, as 8% of men and .5% of women experience some type of  color blindness.  
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 3. What is conditional formatting and why would you apply it?  Give two examples of conditional formats, and explain a method for applying 

conditional formatting.  

 

ANS:  

Conditional formatting applies formatting only when a cell’s value meets a specified condition.  A conditional format could make negative 

numbers red and positive numbers black.   

 

Excel has four conditional formats - data bars, highlighting, color scales, and icon sets. 

 

Students should explain one of the following two methods for applying conditional formatting. 

* Select the range or ranges to which you want to add data bars. 

* In the Styles group on the Home tab, click the Conditional Formatting button, point to Data Bars, and then click a data bar color. 

or 

* Select the range in which you want to highlight cells that match a specified rule. 

* In the Styles group, click the Conditional Formatting button, point to Highlight Cells Rules or Top/Bottom Rules, and then click the 

appropriate rule. 

* Select the appropriate options in the dialog box, and then click the OK button.  
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